
Adobe Photoshop (macOS) cheat sheet

Popular shortcuts
Cmd + T Free Transform

[ Decrease Brush Size

] Increase Brush Size

{ Decrease Brush Hardness

} Increase Brush Hardness

D Default Foreground/Background 
colors

X Switch Foreground/Background 
colors

Cmd + J New layer via copy

Shift + Cmd + J New layer via cut

Shift + Move the 
mouse

(With any selection tool) Add to a 
selection

Option + Left click (Click on brush or swatch) 
Delete brush or swatch

Cmd + Left click Toggle auto-select with move 
tool

Esc Cancel any modal dialog window 
(including the Start Workspace)

Enter Select the first edit field of the 
tool bar

Tab Navigate between fields

Tab + Shift Navigate between fields in 
opposite direction

Option Change Cancel to Reset

Invoke the search experience
Cmd + F Search across Photoshop UI, 

Help & Learn content, and 
Adobe Stock assets. For more 
information, see Photoshop 
search.

Using function keys
F1 Start Help

F2 Cut

F3 Copy

F4 Paste

F5 Show/Hide Brush panel

F6 Show/Hide Color panel

F7 Show/Hide Layers panel

F8 Show/Hide Info panel

Option + F9 Show/Hide Actions panel

F12 Revert

Shift + F5 Fill

Shift + F6 Feather Selection

Shift + F7 Inverse Selection

Selecting tools
Holding down a key temporarily activates a tool. 
Letting go of the key returns to the previous tool.

Shift (Press shortcut key while holding 
Shift) Cycle through tools with 
the same shortcut key

Option + Left click (click on a tool, except Add 
Anchor Point, Delete Anchor 
Point, and Convert Point tools) 
Cycle through hidden tools

V Move tool

M Rectangular Marquee tool

M Elliptical Marquee tool

L Lasso tool

L Polygonal Lasso tool

L Magnetic Lasso tool

W Magic Wand tool

W Quick Selection tool

C Crop tool

C Slice tool

C Slice Select tool

I Eyedropper tool

I Color Sampler tool

I Ruler tool

I Note tool

J Spot Healing Brush tool

J Healing Brush tool

J Patch tool

J Red Eye tool

B Brush tool

B Pencil tool

B Color Replacement tool

B Mixer Brush tool
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S Clone Stamp tool

S Pattern Stamp tool

Y History Brush tool

Y Art History Brush tool

E Eraser tool

E Background Eraser tool

E Magic Eraser tool

G Gradient tool

G Paint Bucket tool

O Dodge tool

O Burn tool

O Sponge tool

P Pen tool

P Freeform Pen tool

T Horizontal Type tool

T Vertical Type tool

T Horizontal Type mask tool

T Vertical Type mask tool

A Path Selection tool

A Direct Selection tool

U Rectangle tool

U Rounded Rectangle tool

U Ellipse tool

U Polygon tool

U Line tool

U Custom Shape tool

H Hand tool

R Rotate View tool

Z Zoom tool

D Default Foreground/Background 
colors

X Switch Foreground/Background 
colors

Q Toggle Standard/Quick Mask 
modes

J Content-Aware Move tool

C Perspective Crop tool

V Artboard tool

R Rotate View tool

/ Toggle Preserve Transparency

{ Decrease Brush Hardness

} Increase Brush Hardness

, Previous Brush

. Next Brush

< First Brush

> Last Brush

View images
Control + Tab Cycle through open documents

Shift + Cmd + ` Switch to previous document

Shift + Cmd + W Close a file in Photoshop and 
open Bridge

Q Toggle between Standard mode 
and Quick Mask mode

F Toggle (forward) between 
Standard screen mode, Full 
screen mode with menu bar, and 
Full screen mode

Shift + F Toggle (backward) between 
Standard screen mode, Full 
screen mode with menu bar, and 
Full screen mode

Space + F Toggle (forward) canvas color 
 (or Control + click canvas 
background and select color)

Space + Shift + F Toggle (backward) canvas color

Double click (Double-click the hand tool) Fit 
image in window

Double click (Double-click the zoom tool) 
Magnify 100%

Cmd + 1 Magnify 100%

Space Switch to Hand tool (when not in 
text-edit mode)

Shift + Move the 
mouse

Simultaneously pan multiple 
documents with Hand tool

Cmd + Space Switch to Zoom In tool

Option + Space Switch to Zoom Out tool

Space + Move the 
mouse

Move Zoom marquee while 
dragging with the Zoom tool

Shift + Enter (In Navigator panel zoom 
percentage box) Apply zoom 
percentage, and keep zoom 
percentage box active
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Cmd + Move the 
mouse

(Over preview in Navigator 
panel) Zoom in on specified area 
of an image

H + Left click (Hold the mouse button) 
Temporarily zoom into an image

Space + Move the 
mouse

Scroll image with Hand tool

Page Up Scroll up 1 screen

Page Down Scroll down 1 screen

Page Up Scroll up 10 units

Page Down Scroll down 10 units

Home Move view to upper-left corner

End Move view to lower-right corner

\ Toggle layer mask on/off as 
rubylith (layer mask must be 
selected)

*Using puppet warp

Esc Cancel completely

Cmd + Z Undo last pin adjustment

Cmd + A Select all pins

Cmd + D Deselect all pins

Shift + Left click Select multiple pins

Shift + Move the 
mouse

Move multiple selected pins

H Temporarily hide pins

Using puppet warp
Esc Cancel completely

Cmd + Z Undo last pin adjustment

Cmd + A Select all pins

Cmd + D Deselect all pins

Shift + Left click Select multiple pins

Shift + Move the 
mouse

Move multiple selected pins

H Temporarily hide pins

Using refine edge
Cmd + Option + R Open the Refine Edge dialog 

box

F Cycle (forward) through preview 
modes

Cycle (backward) through Shift + F

preview modes

X Toggle between original image 
and selection preview

P Toggle between original 
selection and refined version

J Toggle radius preview on and off

Shift + E Toggle between Refine Radius 
and Erase Refinements tools

Using Filter Gallery
Option + Left click (Click on a filter) Apply a new 

filter on top of selected

Control + Cmd + F Reapply last-used filter

Option + Left click (Click a disclosure triangle) 
Open/close all disclosure 
triangles

Cmd Change Cancel button to Default

Option Change Cancel button to Reset

Cmd + Z Undo/Redo

Cmd + Shift + Z Step forward

Cmd + Option + Z Step backward

Using liquify filter
W Forward Warp tool

R Reconstruct tool

C Twirl Clockwise tool

S Pucker tool

B Bloat tool

O Push Left tool

M Mirror tool

T Turbulence tool

F Freeze Mask tool

D Thaw Mask tool

Option + Left click (Click on a tool) Reverse 
direction for Bloat, Pucker, Push 
Left, and Mirror tools

Option + Move the 
mouse

(Drag in preview with 
Reconstruct tool, Displace, 
Amplitwist, or Affine mode 
selected) Continually sample the 
distortion

Up arrow / Down (In Brush Size, Density, 
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arrow Pressure, Rate, or Turbulent 
Jitter text box) 
Decrease/increase brush size by 
2, or density, pressure, rate, or 
turbulent jitter by 1

Left arrow / Right 
arrow

(With Brush Size, Density, 
Pressure, Rate, or Turbulent 
Jitter slider showing) 
Decrease/increase brush size by 
2, or density, pressure, rate, or 
turbulent jitter by 1

Tab Cycle through controls on right 
from top

Shift + Tab Cycle through controls on right 
from bottom

Option Change Cancel to Reset

Using vanishing point
X Zoom 2x (temporary)

Cmd + + Zoom in

Cmd + - Zoom out

Cmd + 0 Fit in view

Double click (on Hand tool) Fit in view

Double click (on Zoom tool) Zoom to center at 
100%

] Increase brush size (Brush, 
Stamp tools)

[ Decrease brush size (Brush, 
Stamp tools)

Shift + ] Increase brush hardness (Brush, 
Stamp tools)

Shift + [ Decrease brush hardness 
(Brush, Stamp tools)

Cmd + Z Undo last action

Cmd + Shift + Z Redo last action

Cmd + D Deselect all

Cmd + H Hide selection and planes

Arrow keys Move selection 1 pixel

Shift + Arrow keys Move selection 10 pixels

Cmd + C Copy

Cmd + V Paste

Cmd + Shift + T Repeat last duplicate and move

Cmd + Move the Fill a selection with image under 

mouse the pointer

Cmd + Option + 
Move the mouse

Create a duplicate of the 
selection as a floating selection

Option + Shift Constrain selection to a 15° 
rotation

Cmd + Left click Select a plane under another 
selected plane

Cmd + Move the 
mouse

Create 90 degree plane off 
parent plane

Del Delete last node while creating 
plane

Double click (On the Create Plane tool) Make 
a full canvas plane, square to the 
camera

Using the Camera Raw dialog box
Note: Holding down a key temporarily activates a tool. 
Letting go of the key returns to the previous tool.

Z Zoom tool

H Hand tool

I White Balance tool

S Color Sampler tool

C Crop tool

A Straighten tool

B Spot Removal tool

E Red Eye Removal tool

Cmd + Option + 1 Basic panel

Cmd + Option + 2 Tone Curve panel

Cmd + Option + 3 Detail panel

Cmd + Option + 4 HSL/Grayscale panel

Cmd + Option + 5 Split Toning panel

Cmd + Option + 6 Lens Corrections panel

Cmd + Option + 7 Camera Calibration panel

Cmd + Option + 9 Presets panel  (macOS 
Universal Access zoom shortcut 
must be disabled in System 
Preferences)

Cmd + Option + 9 Open Snapshots panel

Cmd + Shift + 
Shift + T

Parametric Curve Targeted 
Adjustment tool

Cmd + Shift + 
Shift + H

Hue Targeted Adjustment tool
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Cmd + Shift + 
Shift + S

Saturation Targeted Adjustment 
tool

Cmd + Shift + 
Shift + L

Luminance Targeted Adjustment 
tool

Cmd + Shift + 
Shift + G

Grayscale Mix Targeted 
Adjustment tool

T Last-used Targeted Adjustment 
tool

K Adjustment Brush tool

G Graduated Filter tool

] or [ Increase/decrease brush size

Shift + ] or Shift + [ Increase/decrease brush feather

= or - Increase/decrease Adjustment 
Brush tool flow in increments of 
10

Option Temporarily switch from Add to 
Erase mode for theAdjustment 
Brush tool, or from Erase to Add 
mode

Option + ] or 
Option + [

Increase/decrease temporary 
Adjustment Brush tool size

Option + Shift + ] 
or Option + Shift + 
[

Increase/decrease temporary 
Adjustment Brush tool feather

Option + = or 
Option + -

Increase/decrease temporary 
Adjustment Brush tool flow in 
increments of 10

N Switch to New mode from Add or 
Erase mode of theAdjustment 
Brush tool or the Graduated 
Filter

M Toggle Auto Mask for 
Adjustment Brush tool

Y Toggle Show Mask for 
Adjustment Brush tool

V Toggle pins for Adjustment 
Brush tool

V Toggle overlay for Graduated 
Filter, Spot Removal tool, or Red 
Eye Removal tool.

L or Cmd + ] Rotate image left

R or Cmd + [ Rotate image right

Cmd + + Zoom in

Cmd + - Zoom out

Cmd Temporarily switch to Zoom In 
tool (Doesn’t work when 
Straighten tool is selected. If 
Crop tool is active, temporarily 
switches to Straighten tool)

Option Temporarily switch to Zoom Out 
tool and change the Open Image 
button to Open Copy and the 
Cancel button to Reset

P Toggle preview

F Full screen mode

Shift Temporarily activate the White 
Balance tool and change the 
Open Image button to Open 
Object (Does not work if Crop 
tool is active)

Click the first point; Shift-click additional points:Select 
multiple points in Curves panel

Cmd + Left click (In preview) Add point to curve in 
Curves panel

Arrow keys Move selected point in Curves 
panel (1 unit)

Shift + Arrow keys Move selected point in Curves 
panel (10 units)

Cmd + R Open selected images in 
Camera Raw dialog box from 
Bridge

Shift + Double 
click

(double click image) Open 
selected images from Bridge 
bypassing Camera Raw dialog 
box

Option + Move the 
mouse

(Exposure, Recovery, or Black 
sliders) Display highlights that 
will be clipped in Preview

O Highlight clipping warning

U Shadows clipping warning

Cmd + 1 … to 5: (Filmstrip mode) Add 1 - 
5 star rating

Cmd + . (Filmstrip mode) 
Increase/decrease rating

Cmd + , (Filmstrip mode) 
Increase/decrease rating       
(Film Şeridi Modu) Dereceyi 
arttır/azalt

Cmd + 6 (Filmstrip mode) Add red label

(Filmstrip mode) Add yellow Cmd + 7
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label

Cmd + 8 (Filmstrip mode) Add green label

Cmd + 9 (Filmstrip mode) Add blue label

Cmd + Shift + 0 (Filmstrip mode) Add purple 
label

Cmd + K Camera Raw preferences

Option + Shift (On open) Deletes Adobe 
Camera Raw preferences

</p><p>*Using the Camera Raw 
dialog box

Note: Holding down a key temporarily activates a tool. 
Letting go of the key returns to the previous tool.

Z Zoom tool

H Hand tool

I White Balance tool

S Color Sampler tool

C Crop tool

A Straighten tool

B Spot Removal tool

E Red Eye Removal tool

Cmd + Option + 1 Basic panel

Cmd + Option + 2 Tone Curve panel

Cmd + Option + 3 Detail panel

Cmd + Option + 4 HSL/Grayscale panel

Cmd + Option + 5 Split Toning panel

Cmd + Option + 6 Lens Corrections panel

Cmd + Option + 7 Camera Calibration panel

Cmd + Option + 9 Presets panel  (macOS 
Universal Access zoom shortcut 
must be disabled in System 
Preferences)

Cmd + Option + 9 Open Snapshots panel

Cmd + Shift + 
Shift + T

Parametric Curve Targeted 
Adjustment tool

Cmd + Shift + 
Shift + H

Hue Targeted Adjustment tool

Cmd + Shift + 
Shift + S

Saturation Targeted Adjustment 
tool

Cmd + Shift + 
Shift + L

Luminance Targeted Adjustment 
tool

Cmd + Shift + 
Shift + G

Grayscale Mix Targeted 
Adjustment tool

T Last-used Targeted Adjustment 
tool

K Adjustment Brush tool

G Graduated Filter tool

] or [ Increase/decrease brush size

Shift + ] or Shift + [ Increase/decrease brush feather

= or - Increase/decrease Adjustment 
Brush tool flow in increments of 
10

Option Temporarily switch from Add to 
Erase mode for theAdjustment 
Brush tool, or from Erase to Add 
mode

Option + ] or 
Option + [

Increase/decrease temporary 
Adjustment Brush tool size

Option + Shift + ] 
or Option + Shift + 
[

Increase/decrease temporary 
Adjustment Brush tool feather

Option + = or 
Option + -

Increase/decrease temporary 
Adjustment Brush tool flow in 
increments of 10

N Switch to New mode from Add or 
Erase mode of theAdjustment 
Brush tool or the Graduated 
Filter

M Toggle Auto Mask for 
Adjustment Brush tool

Y Toggle Show Mask for 
Adjustment Brush tool

V Toggle pins for Adjustment 
Brush tool

V Toggle overlay for Graduated 
Filter, Spot Removal tool, or Red 
Eye Removal tool.

L or Cmd + ] Rotate image left

R or Cmd + [ Rotate image right

Cmd + + Zoom in

Cmd + - Zoom out

Cmd Temporarily switch to Zoom In 
tool (Doesn’t work when 
Straighten tool is selected. If 
Crop tool is active, temporarily 
switches to Straighten tool)
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Option Temporarily switch to Zoom Out 
tool and change the Open Image 
button to Open Copy and the 
Cancel button to Reset

P Toggle preview

F Full screen mode

Shift Temporarily activate the White 
Balance tool and change the 
Open Image button to Open 
Object (Does not work if Crop 
tool is active)

Click the first point; Shift-click additional points:Select 
multiple points in Curves panel

Cmd + Left click (In preview) Add point to curve in 
Curves panel

Arrow keys Move selected point in Curves 
panel (1 unit)

Shift + Arrow keys Move selected point in Curves 
panel (10 units)

Cmd + R Open selected images in 
Camera Raw dialog box from 
Bridge

Shift + Double 
click

(double click image) Open 
selected images from Bridge 
bypassing Camera Raw dialog 
box

Option + Move the 
mouse

(Exposure, Recovery, or Black 
sliders) Display highlights that 
will be clipped in Preview

O Highlight clipping warning

U Shadows clipping warning

Cmd + 1 … to 5: (Filmstrip mode) Add 1 - 
5 star rating

Cmd + . (Filmstrip mode) 
Increase/decrease rating

Cmd + , (Filmstrip mode) 
Increase/decrease rating       
(Film Şeridi Modu) Dereceyi 
arttır/azalt

Cmd + 6 (Filmstrip mode) Add red label

Cmd + 7 (Filmstrip mode) Add yellow 
label

Cmd + 8 (Filmstrip mode) Add green label

Cmd + 9 (Filmstrip mode) Add blue label

(Filmstrip mode) Add purple Cmd + Shift + 0

label

Cmd + K Camera Raw preferences

Option + Shift (On open) Deletes Adobe 
Camera Raw preferences

Using the Black-and-White dialog 
box

Shift + Cmd + 
Option + B

Open the Black-and-White dialog 
box

Up arrow / Down 
arrow

Increase/decrease selected 
value by 1%

Shift + Up arrow / 
Down arrow

Increase/decrease selected 
value by 10%

Left click + Move 
the mouse

Change the values of the closest 
color slider

Using Curves
Cmd + M Open the Curves dialog box

+ Select next point on the curve

- Select the previous point on the 
curve

Shift + Left click (Click on points) Select multiple 
points on the curve

Cmd + D Deselect a point

Del (Select a point first and press 
Delete) To delete a point on the 
curve

Arrow keys Move the selected point 1 unit

Shift + Arrow keys Move the selected point 10 units

Option + Move the 
mouse

(Drag Black/white point sliders) 
Display highlights and shadows 
that will be clipped

Cmd + Left click (On image) Set a point to the 
composite curve

Shift + Cmd + Left 
click

(Click the image) Set a point to 
the channel curves

Option + Left click (On the field) Toggle grid size

Select and move objects
Space + Move the 
mouse

(Any marquee tool except single 
column and single row) 
 Reposition marquee while 
selecting. Applies to shape toos
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Shift + Move the 
mouse

(Any selection tool) Add to a 
selection

Option + Move the 
mouse

(Any selection tool) Subtract 
from a selection

Shift + Option + 
Move the mouse

(Any selection tool except Quick 
Selection tool) Intersect a 
selection

Shift + Move the 
mouse

Constrain marquee to square or 
circle (if no other selections are 
active). Applies to shape tools

Option + Move the 
mouse

Draw marquee from center (if no 
other selections are active)

Shift + Option + 
Move the mouse

Constrain shape and draw 
marquee from center

Cmd (except when Hand, Slice, Path, 
Shape, or any Pen tool is 
selected) Switch to Move tool

Option + Move the 
mouse

Switch from Magnetic Lasso tool 
to Lasso tool

Option + Left click Switch from Magnetic Lasso tool 
to polygonal Lasso tool

Enter or Esc or 
Cmd + .

Apply/cancel an operation of the 
Magnetic Lasso

Option + Move the 
mouse

(On Move tool) Move copy of 
selection

Arrow keys (On any selection) Move 
selection area 1 pixel. Hold down 
Shift to move 10 pixels

Arrow keys (On Move tool) Move selection 1 
pixel. Applies to shape tools. 
Hold down Shift to move 10 
pixels

Cmd + Arrow keys Move layer 1 pixel when nothing 
selected on layer. Hold down 
Shift to move 10 pixels

[ or ] (On Magnetic Lasso tool) 
Increase/decrease detection 
width

Enter or Esc (On Crop tool) Accept cropping 
or exit cropping

/ Toggle crop shield off and on

Option + Move the 
mouse

(Ruler tool, Alt-drag end point) 
Make protractor

Shift + Move the 
mouse

(Drag guide) Snap guide to ruler 
ticks (except when View > Snap 
is unchecked)

Option + Move the 
mouse

(Drag guide) Convert between 
horizontal and vertical guide

Transform selections, selection 
borders, and paths

Alt Transform from center or reflect

Shift Constrain

Cmd Distort

Enter Apply

Cmd + . or Esc Cancel

Cmd + Option + T Free transform with duplicate 
data

Cmd + Shift + 
Option + T

Transform again with duplicate 
data

Edit paths
Shift + Left click (Direct selection tool) Select 

multiple anchor points

Option + Left click (Direct selection tool) Select 
entire path

Cmd + Option + 
Move the mouse

(On Pen (any Pen tool), Path 
Selection or Direct Selection 
tool) Duplicate a path

Cmd Switch from Path Selection, Pen, 
Add Anchor Point, Delete Anchor 
Point, or Convert Point tools to 
Direct Selection tool

Option Switch from Pen tool or Freeform 
Pen tool to Convert Point tool 
when pointer is over anchor or 
direction point

Double click (Magnetic pen tool) Close path

Option + Double 
click

(Magnetic pen tool) Close path 
with straight-line segment

Painting
Control + Option + 
Cmd + Left click + 
Move the mouse

(on any painting tool) Select 
foreground color from color 
picker

(on any painting tool or any 
shape tool) Select foreground 
color from image with 
Eyedropper tool (except when 

Option
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Paths option is selected)

Option + Left click (Eyedropper tool) Select 
background color

Shift (Eyedropper tool) Color sampler 
tool

Option + Left click (Color sampler tool) Deletes 
color sampler

[0 - 9] (Any painting or editing tool  + 
number keys) Sets opacity, 
tolerance, strength, or exposure 
for painting mode

Shift + [0 - 9] (Any painting or editing tool) 
 (when airbrush option is 
enabled, omit Shift) Sets flow for 
painting mode (e.g., 0 = 100%, 1 
= 10%, 4 then 5 in quick 
succession = 45%)

Option + Shift + [0 
- 9]

Mixer Brush changes Mix setting

[0 - 9] Mixer Brush changes Wet setting

0 Mixer Brush changes Wet and 
Mix to zero

Shift + + or Shift + 
-

Cycle through blending modes

Del or Shift + Del Open Fill dialog box on 
background or standard layer

Option + Del or 
Cmd + Del

Fill with foreground or 
background color. Hold down 
Shift to preserve transparency

Cmd + Option + 
Backspace

Fill from history. Hold down Shift 
to preserve transparency

Shift + Backspace Displays Fill dialog box

/ Lock transparent pixels on/off

Shift + Left click (Any painting tool) Connects 
points with a straight line

Blending modes
Shift + + or Shift + 
-

Cycle through blending modes

Shift + Option + N Normal

Shift + Option + I Dissolve

Shift + Option + Q Behind (Brush tool only)

Shift + Option + R Clear (Brush tool only)

Shift + Option + K Darken

Shift + Option + M Multiply

Shift + Option + B Color Burn

Shift + Option + A Linear Burn

Shift + Option + G Lighten

Shift + Option + S Screen

Shift + Option + D Color Dodge

Shift + Option + W Linear Dodge

Shift + Option + O Overlay

Shift + Option + F Soft Light

Shift + Option + H Hard Light

Shift + Option + V Vivid Light

Shift + Option + J Linear Light

Shift + Option + Z Pin Light

Shift + Option + L Hard Mix

Shift + Option + E Difference

Shift + Option + X Exclusion

Shift + Option + U Hue

Shift + Option + T Saturation

Shift + Option + C Color

Shift + Option + Y Luminosity

Shift + Option + D (Sponge tool) Desaturate

Shift + Option + S (Sponge tool) Saturate

Shift + Option + S (Dodge tool/Burn tool) 
Dodge/burn shadows

Shift + Option + M (Dodge tool/Burn tool) 
Dodge/burn midtones

Shift + Option + H (Dodge tool/Burn tool) 
Dodge/burn highlights

Shift + Option + N Set blending mode to Threshold 
for bitmap images, Normal for all 
other images

Select and edit text
Cmd + Move the 
mouse

(Drag type when Type layer is 
selected) Move type in image

Shift + Arrow keys 
or Cmd + Shift + 
Left arrow / Right 
arrow

Select 1 character left/right or 1 
line down/up, or 1 word left/right

Shift + Left click Select characters from insertion 
point to mouse click point

Move 1 character left/right, 1 line Arrow keys
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down/up, or 1 word left/right

Shift + Left click Create a new text layer, when a 
text layer is selected in the 
Layers panel

Double click Select a word

Click three times 
(rapidly)

Select a line

Double click + 
Double click

(Quadruple-click) Select 
paragraph

Click three times 
(rapidly) + Double 
click

(Quintuple click) Select story

Cmd + H Show/Hide selection on selected 
type

Cmd Display the bounding box for 
transforming text when editing 
text, or activate Move tool if 
cursor is inside the bounding box

Cmd + Move the 
mouse

(Drag a bounding box handle) 
Scale text within a bounding box 
when resizing the bounding box

Space + Move the 
mouse

Move text box while creating text 
box

Format type
Cmd + Shift + L (Horizontal Type tool) Align left

Cmd + Shift + C (Horizontal Type tool) Align 
center

Cmd + Shift + R (Horizontal Type tool) Align right

Cmd + Shift + L (Vertical Type tool) Align left

Cmd + Shift + C (Vertical Type tool) Align center

Cmd + Shift + R (Vertical Type tool) Align right

Cmd + Shift + X Choose 100% horizontal scale

Cmd + Shift + 
Option + X

Choose 100% vertical scale

Cmd + Shift + 
Option + A

Choose Auto leading

Cmd + Shift + Q Choose 0 for tracking

Cmd + Shift + J Justify paragraph, left aligns last 
line

Cmd + Shift + F Justify paragraph, justifies all

Cmd + Control + 
Shift + Option + H

Toggle paragraph hyphenation 
on/off

Cmd + Shift + 
Option + T

Toggle single/every-line 
composer on/off

Cmd + Shift + < or 
Cmd + Shift + >

Decrease or increase type size 
of selected text 2 points or 
pixels. Hold down Alt (Win) or 
Option (macOS) to 
decrease/increase by 10

Option + Up arrow 
/ Down arrow

Decrease or increase leading 2 
points or pixels. Hold down Ctrl 
(Windows) or Command 
(macOS) to decrease/increase 
by 10

Shift + Option + 
Up arrow / Down 
arrow

Decrease or increase baseline 
shift 2 points or pixels. Hold 
down Ctrl (Windows) or 
Command (macOS) to 
decrease/increase by 10

Option + Left 
arrow / Right 
arrow

Decrease or increase 
kerning/tracking 20/1000 ems. 
Hold down Ctrl (Windows) or 
Command (macOS) to 
decrease/increase by 10

Slice and optimize
Cmd Toggle between Slice tool and 

Slice Selection tool

Shift + Move the 
mouse

Draw square slice

Option + Move the 
mouse

Draw from center outward

Shift + Option + 
Move the mouse

Draw square slice from center 
outward

Space + Move the 
mouse

Reposition slice while creating 
slice

Control + Left click (click on slice) Open context-
sensitive menu

Using actions panel
Option + Left click (Click the check mark next to a 

command) Turn command on 
and all others off, or turn all 
commands on

Option + Left click Turn current modal control on 
and toggle all other modal 
controls

Option + Double (double click action or action set) 
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click Change action or action set 
options

Double click (To recorded command) Display 
Options dialog box for recorded 
command

Cmd + Double 
click

Play entire action

Option + Left click (To triangle) Collapse/expand all 
components of an action

Cmd + Left click Play a command

Option + Left click (Click the New Action button) 
Create new action and begin 
recording without confirmation

Shift + Left click (Click the action/command) 
Select contiguous items of the 
same kind

Cmd + Left click (Click the action/command) 
Select discontiguous items of the 
same kind

Using adjustment layers
Note: If you prefer channel shortcuts starting with 
Alt/Option + 1 for red, choose Edit > Keyboard 
Shortcuts, and select Use Legacy Channel Shortcuts. 
Then restart Photoshop.

Option + 3 Choose specific channel for 
adjustment (Red)

Option + 4 Choose specific channel for 
adjustment (Green)

Option + 5 Choose specific channel for 
adjustment (Blue)

Option + 2 Choose composite channel for 
adjustment

Del Delete adjustment layer

Option + Left click (To Auto button) Define Auto 
options for Levels or Curves

Using the Animation panel in 
Frames mode

Shift + Left click (Click on second frame) 
Select/deselect multiple 
contiguous frames

(Click multiple frames) 
Select/deselect multiple 

Cmd + Left click

discontiguous frames

Alt (Use Paste Frames command 
from the Panel pop�up menu) 
Paste using previous settings 
without displaying the dialog box

Using the Brush panel
Option + Left click (Click on the brush) Delete brush

Double click (Double click on the brush) 
Rename brush

Control + Option + 
Move the mouse

Drag left or right to change brush 
size

Control + Option + 
Move the mouse

Drag mouse down or up to 
decrease/increase brush 
softness/hardness

. or , Select previous/next brush size

Shift + , or Shift + . Select first/last brush

Caps Lock or Shift 
+ Caps Lock

Display precise cross hair for 
brushes

Shift + Option + P Toggle airbrush option

Using panels
Option + Left click (Click new button) Set options 

for new items (except for 
Actions, Animation, Styles, 
Brushes, Tool Presets, and 
Layer Comps panels)

Option + Left click (Click Delete button) Delete 
without confirmation (except for 
the Brush panel)

Shift + Enter Apply value and keep text box 
active

Tab Show/Hide all panels

Shift + Tab Show/Hide all panels except the 
toolbox and options bar

Enter (Select tool and then press 
Enter) Highlight options bar

Shift + Up arrow / 
Down arrow

Increase/decrease selected 
values by 10

Channels panel
Note: If you prefer channel shortcuts starting with 
Ctrl/Command + 1 for red, choose Edit > Keyboard 
Shortcuts, and select Use Legacy Channel Shortcuts.
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Cmd + 3 (Red) Select individual channels

Cmd + 4 (Green) Select individual 
channels

Cmd + 5 (Blue) Select individual channels

Cmd + 2 Select composite channel

Cmd + Left click (Click channel thumbnail) Load 
channel as selection

Option + Cmd + 3 Load channel as selection (red)

Option + Cmd + 4 Load channel as selection 
(green)

Option + Cmd + 5 Load channel as selection (blue)

Cmd + Shift + Left 
click

(Click channel thumbnail) Add to 
current selection

Option + Cmd + 
Left click

(Click channel thumbnail) 
Subtract from current selection

Cmd + Shift + 
Option + Left click

(Click channel thumbnail) 
Intersect with current selection

Option + Left click (Click Save Selection As 
Channel button) Set options for 
Save Selection As Channel 
button

Cmd + Left click (Click Create New Channel 
button) Create a new spot 
channel

Shift + Left click (Click color channel) 
Select/deselect multiple color-
channel selection

Shift + Left click (Click alpha channel) 
Select/deselect alpha channel 
and show/hide as a rubylith 
overlay

Double click (Double click alpha spot or spot 
channel thumbnail) Display 
channel options

~ Toggle composite and grayscale 
mask in Quick Mask mode

Clone source panel
Option + Shift Show Clone Source (overlays 

image)

Option + Shift + 
Arrow keys

Nudge Clone Source

Option + Shift + < 
or Option + Shift + 
>

Rotate Clone Source

Option + Shift + [ 
or Option + Shift + 
]

Scale (increase or reduce size) 
Clone Source

Channels
Option + Left click (Click color in color bar) Select 

background color

Control + Left click (click color bar) Display Color 
Bar menu

Shift + Left click (Click color bar) Cycle through 
color choices

History panel
Option (Click New Snapshot) Create a 

new snapshot

Double click Rename snapshot

Cmd + Shift + Z Step forward through image 
states

Cmd + Option + Z Step backward through image 
states

Option + Left click (Click the image state) Duplicate 
any image state, except the 
current state

Option (Click Clear History in History 
panel pop�up menu) 
Permanently clear history (no 
Undo)

Using the Layers panel
Cmd + Left click (Click layer thumbnail) Load 

layer transparency as a selection

Cmd + Shift + Left 
click

(Click layer thumbnail) Add to 
current selection

Cmd + Option + 
Left click

(Click layer thumbnail) Subtract 
from current selection

Cmd + Shift + 
Option + Left click

(Click layer thumbnail) Intersect 
with current selection

Cmd + Left click (Click filter mask thumbnail) 
Load filter mask as a selection

Cmd + Shift + N New layer

Cmd + J New layer via copy

Shift + Cmd + J New layer via cut

Cmd + G Group layers
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Cmd + Shift + G Ungroup layers

Cmd + Option + G Create/release clipping mask

Cmd + Option + A Select all layers

Cmd + Shift + E Merge visible layers

Option + Left click (Click New Layer button) Create 
new empty layer with dialog box

Cmd + Left click (Click New Layer button) Create 
new layer below target layer

Option + . Select top layer

Option + , Select bottom layer

Shift + Option + [ 
or Shift + Option + 
]

Add to layer selection in Layers 
panel

Option + [ or 
Option + ]

Select next layer down/up

Cmd + [ or Cmd + 
]

Move target layer down/up

Cmd + Shift + 
Option + E

Merge a copy of all visible layers 
into target layer

Cmd + E (First, highlight layers you want 
to merge) Merge layers

Cmd + Shift + [ or 
Cmd + Shift + ]

Move layer to bottom or top

Option (Use Merge Down command 
from the Panel pop�up menu) 
Copy current layer to layer below

Option (Use Merge Visible command 
from the Panel pop�up menu) 
Merge all visible layers to a new 
layer above the currently 
selected layer

Control + Left click (click the eye icon) Show/hide 
this layer/layer group only or all 
layers/layer groups

Option (Click the eye icon) Show/hide 
all other currently visible layers

/ Toggle lock transparency for 
target layer, or last applied lock

Double click (Double-click layer effect/style) 
Edit layer effect/style, options

Option + Double 
click

(Double-click layer effect/style) 
Hide layer effect/style

Double click (Double-click the layer) Edit layer 
style

Shift + Left click (Click vector mask thumbnail) 
Disable/enable vector mask

Double click (Double-click layer mask 
thumbnail) Open Layer Mask 
Display Options dialog box

Shift + Left click (Click layer mask thumbnail) 
Toggle layer mask on/off

Shift + Left click (Click layer mask thumbnail) 
Toggle filter mask on/off

Option + Left click (Click layer mask thumbnail) 
Toggle between layer 
mask/composite image

Option + Left click (Click filter mask thumbnail) 
Toggle between filter 
mask/composite image

\ or Shift + Option 
+ Left click

Toggle rubylith mode for layer 
mask on/off

Double click (Double-click type layer 
thumbnail) Select all type; 
temporarily select Type tool

Option + Left click (Click the line dividing two 
layers) Create a clipping mask

Double click (Double-click the layer name) 
Rename layer

Double click (Double-click the filter effect) Edit 
filter settings

Double click (Double-click the Filter Blending 
icon) Edit the Filter Blending 
options

Cmd + Left click (Click New Group button) Create 
new layer group below current 
layer/layer set

Option + Left click (Click New Group button) Create 
new layer group with dialog box

Option + Left click (Click Add Layer Mask button) 
Create layer mask that hides 
all/selection

Cmd + Left click (Click Add Layer Mask button) 
Create vector mask that reveals 
all/path area

Cmd + Option + 
Left click

(Click Add Layer Mask button) 
Create vector mask that hides all 
or displays path area

Info panel

(click layer group and choose 
Group Properties) Display layer 

Control + Left click
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group properties

Double click (Double-click on the group) 
Display layer group properties

Shift + Left click Select/deselect multiple 
contiguous layers

Cmd + Left click Select/deselect multiple 
discontiguous layers

Layer Comps panel
Option + Left click (Click Create New Layer Comp 

button) Create new layer comp 
without the New Layer Comp 
box

Double click (Double-click layer comp) Open 
Layer Comp Options dialog box

Double click (Doubleclick layer comp name) 
Rename in-line

Shift + Left click Select/deselect multiple 
contiguous layer comps

Cmd + Left click Select/deselect multiple 
discontiguous layer comps

Paths panel
Cmd + Left click (Click pathname) Load path as 

selection

Cmd + Shift + Left 
click

(Click pathname) Add path to 
selection

Cmd + Option + 
Left click

(Click pathname) Subtract path 
from selection

Cmd + Shift + 
Option + Left click

(Click pathname) Retain 
intersection of path as selection

Cmd + Shift + H Hide path

Option + Left click Set options for Fill Path with 
Foreground Color button, Stroke 
Path with Brush button, Load 
Path as a Selection button, Make 
Work Path from Selection button, 
and Create New Path button

Swatches panel
Left click (Click in empty area of panel) 

Create new swatch from 
foreground color

(Click swatch) Set swatch color Cmd + Left click

as background color

Option + Left click (Click swatch) Delete swatch

Extract and Pattern Maker (optional 
plug-ins)

Result (Extract and Pattern Maker)

Cmd + 0 Fit in window

Cmd + + Zoom in

Cmd + - Zoom out

Tab Cycle through controls on right 
from top

Shift + Tab Cycle through controls on right 
from bottom

Space Temporarily activate Hand tool

Option Change Cancel to Reset

Result (Extract only)

B Edge Highlighter tool

G Fill tool

I Eyedropper tool

C Cleanup tool

T Edge Touchup tool

Option (Click Edge Highlighter/Eraser 
tool) Toggle between Edge 
Highlighter tool and Eraser tool

Cmd (With Edge Highlighter tool 
selected) Toggle Smart 
Highlighting

Option + Del Remove current highlight

Cmd + Del Highlight entire image

Shift + Left click (With Fill tool selected) Fill 
foreground area and preview 
extraction

Cmd + Move the 
mouse

Move mask when Edge Touchup 
tool is selected

Optiion + Move 
the mouse

Add opacity when Cleanup tool 
is selected

X Toggle Show menu options in 
preview between Original and 
Extracted

Shift + X Enable Cleanup and Edge 
Touchup tools before preview

Cycle through Display menu in F
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preview from top to bottom

Shift + F Cycle through Display menu in 
preview from bottom to top

Up arrow / Down 
arrow

(In Brush Size text box) 
Increase/decrease brush size by 
1

Left arrow / Right 
arrow

(With Brush Size Slider showing) 
Decrease/increase brush size by 
1

[0 - 9] Set strength of Cleanup or Edge 
Touch�up tool

Result (Pattern Maker only)

Cmd + D Delete current selection

Cmd + Z Undo a selection move

Cmd + G Generate or generate again

Shift + Option + 
Left click

(Select while holding) Intersect 
with current selection

X Toggle view: original/generated 
pattern

Home Go to first tile in Tile History

End Go to last tile in Tile History

Left or Page Up Go to previous tile in Tile History

Right or Page 
Down

Go to next tile in Tile History

Del Delete current tile from Tile 
History

Arrow keys Nudge selection when viewing 
the original

Shift + Arrow keys Increase selection nudging when 
viewing the original
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